INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH INTEL® PRODUCTS. NO LICENSE, EXPRESS OR IMPLIED, BY
ESTOPPEL OR OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS IS GRANTED BY THIS DOCUMENT. EXCEPT AS PROVIDED IN
INTEL’S TERMS AND CONDITIONS OF SALE FOR SUCH PRODUCTS, INTEL ASSUMES NO LIABILITY WHATSOEVER, AND INTEL DISCLAIMS
ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF INTEL PRODUCTS INCLUDING LIABILITY OR WARRANTIES
RELATING TO FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, OR INFRINGEMENT OF ANY PATENT, COPYRIGHT OR OTHER
INTELLECTUAL PROPERTY RIGHT. Intel products are not intended for use in medical, life saving, or life sustaining applications.

Intel may make changes to specifications and product descriptions at any time, without notice.

This Intel® Springware Architecture Products on Windows Configuration Guide as well as the software described in it is furnished under license and
may only be used or copied in accordance with the terms of the license. The information in this manual is furnished for informational use only, is
subject to change without notice, and should not be construed as a commitment by Intel Corporation. Intel Corporation assumes no responsibility or
liability for any errors or inaccuracies that may appear in this document or any software that may be provided in association with this document.

Except as permitted by such license, no part of this document may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means without express written consent of Intel Corporation.

Copyright © 2003, Intel Corporation

AnyPoint, BoardWatch, BunnyPeople, CablePort, Celeron, Chips, CT Media, Dialogic, DM3, EtherExpress, ETOX, FlashFile, i386, i486, i960, ICOMP,
Intel Inside logo, Intel NetBurst, Intel NetMerge, Intel NetStructure, Intel SingleDriver, Intel SpeedStep, Intel StrataFlash, Intel TeamStation, Intel Xeon,
Intel XScale, ILink, Itanium, MCS, MMX, MMX logo, Optimizer logo, OverDrive, Paragon, PDCharm, Pentium, Pentium II Xeon, Pentium III Xeon,
Performance at Your Command, RemoteExpress, SmartDie, Solutions960, Sound Mark, StorageExpress, The Computer Inside., The Journey Inside,
TokenExpress, VoiceBrick, VTune, and Xircom are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and
other countries.

* Other names and brands may be claimed as the property of others.

Publication Date: November 2003

Document Number: 05-2083-001

Intel Converged Communications, Inc.
1515 Route 10
Parsippany, NJ 07054

For Technical Support, visit the Intel Telecom Support Resources website at:
http://developer.intel.com/design/telecom/support

For Products and Services Information, visit the Intel Telecom Products website at:
http://www.intel.com/design/network/products/telecom

For Sales Offices and other contact information, visit the Where to Buy Intel Telecom Products page at:
http://www.intel.com/buy/wtb/wtb1028.htm
Contents

4.1 System Property Sheet ................................................................. 39
4.2 Telephony Bus Property Sheet ..................................................... 40
4.3 Interface Property Sheet ............................................................ 41
4.4 Misc Property Sheet ................................................................. 42
4.5 TDM Bus Configuration Property Sheet ......................................... 48
4.6 Country Property Sheet ............................................................. 58
4.7 Files Property Sheet ................................................................. 62

5 DNI Parameter Reference .................................................................. 63

6 Silence Compressed Record Parameter Reference ............................ 71

Index ............................................................................................... 73
Figures

1  DCM Main Window ................................................................. 14
2  Misc Property Sheets. ............................................................. 15
3  TDM Bus Configuration Property Sheet ..................................... 16
4  SCR Parameters Illustrated .................................................... 20
5  Computer Name Dialog Box .................................................... 25
6  System Property Sheet .......................................................... 26
Tables

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Intel Dialogic Springware PCI Boards</td>
<td>21</td>
</tr>
<tr>
<td>2</td>
<td>Device Sorting Example</td>
<td>35</td>
</tr>
</tbody>
</table>
Revision History

This revision history summarizes the changes made in each published version of this document.

<table>
<thead>
<tr>
<th>Document No.</th>
<th>Publication Date</th>
<th>Description of Revisions</th>
</tr>
</thead>
<tbody>
<tr>
<td>05-2083-001</td>
<td>November 2003</td>
<td>Initial version of document.</td>
</tr>
</tbody>
</table>
About This Publication

The following topics provide information about this Intel® Springware Architecture Products on Windows Configuration Guide.

- Purpose
- Intended Audience
- How to Use This Publication
- Related Information

Purpose

This guide provides information about configuring Intel® Dialogic® Springware Architecture PCI boards in a Windows® environment. Configuration procedures are included as well as descriptions of configuration files and configuration parameters.

Intended Audience

This information is for:

- Developers
  - System, application, and technology developers
  - Toolkit vendors
  - VARs/system integrators
- System Operators:
  - System and network administrators
  - Support personnel (crafts person)

How to Use This Publication

This information is organized as follows:

- Chapter 1, “Configuration Overview” describes the major configuration steps in the order in which they are performed, and provides a brief overview of each aspect of configuring a system containing Intel Dialogic on Springware architecture boards.
- Chapter 2, “Configuration Details” provides details about using the configuration manager (DCM), including information about the TDM Bus. Also provides details about the Voice.prm file.
- Chapter 3, “Configuration Procedures” contains detailed procedural information for configuring a system that uses Springware architecture boards.
• Chapter 4, “DCM Parameter Reference” describes each parameter associated with the DCM. Included are a description, list of values, and configuration guidelines.

• Chapter 5, “DNI Parameter Reference” describes each parameter associated with the digital network interface (DNI) parameter file (Spandti.prm). Included are a description, list of values, and configuration guidelines.

• Chapter 6, “Silence Compressed Record Parameter Reference” describes each parameter associated with Silence Compressed Record parameters contained in the Voice.prm file.

Related Information

For additional information related to configuring an Intel Dialogic product, see the following:

• For timely information that may affect configuration, see the Release Guide and Release Update. Be sure to check the online Release Update for the system release you are using for any updates or corrections to this publication.

• For information about installing the system software, see the system software installation guide supplied with your release.

• For additional information about the DCM, including parameter information, refer to the DCM Online Help.

• For information about administrative tasks related to this release, see the system administration guide supplied with your release.


• [http://developer.intel.com/design/telecom/support/](http://developer.intel.com/design/telecom/support/) for support information
Configuration Overview

The configuration overview describes the major configuration steps in the order in which they are performed. The overview also provides a brief summary of each aspect of configuring a system that contains Intel® Dialogic® Springware boards.

- Major Configuration Steps
- The Configuration Process

1.1 Major Configuration Steps

The following major steps are used to configure a system containing Intel Dialogic Springware boards:

1. Starting the configuration manager (DCM)
2. Modifying other DCM Property Sheet parameters
3. Setting the TDM bus clock source (optional)
4. Configuring ISDN protocols
5. Downloading Protocol and Country Dependent Parameter file
6. Configuring the Digital Network Interface Parameters
7. Configuring Voice Parameters
8. Verifying Device Names (optional)
9. Initializing the system
10. Reconfiguring the system (optional)

1.2 The Configuration Process

Once the Intel Dialogic System Release is installed, you start the configuration process by invoking the configuration manager (DCM). The configuration parameters that you select in the DCM are used by the downloader to initialize the system when the boards are started. For detailed procedures, see Chapter 3, “Configuration Procedures”. An overview of the configuration process is provided in the following sections.

Starting the configuration manager

Within the DCM, each board has a set of property sheets that display the board’s configuration parameters. The parameters are grouped by tabs according to the type of board functionality they affect (for example, the Telephony Bus or Interface tabs). For details about the DCM, including property sheets and parameters, see the DCM Online Help.
Modifying DCM Property Sheet Parameters

This step provides general instructions for modifying DCM parameters. For details about DCM property sheets and the associated parameters, see Chapter 4, “DCM Parameter Reference”.

Setting the TDM Bus Clock Source

This step involves using the DCM to access the TDM Bus Configuration property sheet and setting the clock source. The source for clocking depends on the bus mode in which the system runs. The bus mode is determined by the capability of the devices installed in your system. The system automatically determines the bus mode on the basis of installed devices.

Configuring ISDN Protocols

For boards that interface to T1 or E1 lines and use an ISDN protocol, you are required to configure each T1 or E1 interface by selecting a specific ISDN protocol using the DCM.

Downloading the Protocol and Country Dependent Parameter File

For T1 boards using the CAS protocol or E1 boards using the R2 protocol, you will need to configure each T1 or E1 interface using the Global Call country dependent parameters.

Configuring the Digital Network Interface Parameters

The digital network interface (DNI) parameter file, Spandti.prm, is an ASCII text file used by the Intel Dialogic System Software to initialize the firmware configuration for the front end of digital network interface Springware boards. If the default settings in the Spandti.prm file aren’t appropriate for your application, you can modify them.

Configuring Voice Parameters

This step involves adjusting parameters in the Voice.prm file for frequency shift keying (FSK), signal delay adjustments, and silence compressed record. The Voice.prm file is downloaded to all Springware voice boards during the installation and configuration process.

Verifying Device Names

This optional step consists of examining the Voxcfg file against the device name assignment rules.

Initializing the System

During system initialization, all required firmware for an Intel Dialogic board is downloaded and configured using the identified files and parameter settings.

Reconfiguring the System

If hardware is added or configuration parameters need to be modified, the system must be reconfigured. Parameter changes can be made by invoking the DCM and changing the parameter values as needed. The system is then re-initialized by restarting the Intel Dialogic System.
This chapter provides details about the configuration manager (DCM) graphical user interface and the Voice.prm configuration file.

- Configuration Manager (DCM) ................................................................. 13
- TDM Bus Parameters ........................................................................ 16
- Voice Parameters ............................................................................. 17
- Boards Supported ............................................................................. 20

### 2.1 Configuration Manager (DCM)

The configuration manager (DCM) utility is a graphical user interface (GUI) that allows you to customize board, system, and TDM bus configurations. The interface is used to modify parameter settings, start and stop the system, and start and stop individual boards. In addition, the DCM can start the system using the default configuration settings.

The DCM main window contains pull-down menus, shortcut icons, a system window, and a status window. The system window contains a tree structure of the boards installed in your system. The top line of the display, Configured Devices on..., shows the name of the computer you connected to. If you entered an IP address instead of a computer name, the IP address is shown. Refer to Figure 1.
The first level of the tree structure shows the board families or categories of boards currently installed in your system, and also shows the TDM bus, which refers to the resource bus used to carry information between boards. The next level displays the model names of the boards in your system. If the board model names are not displayed, click the family name node(s) to expand the tree structure.

The status window, located at the bottom of the main window, is used to display descriptive text when administrative events are received. For example, it will display “System started” when the system is started and “Device detected” when a device has been detected. The DCM also supports rollover help. When selecting a menu item, or when the mouse is on a particular tool bar icon, a description of the menu item or icon is displayed in the status window.

Within the DCM, each board has a set of property sheets that display a set of board’s configuration parameters. Each property sheet displays a different set of parameters based on the functionality they affect. To access a board’s property sheets, double-click on the board model name in the system window. The Misc property sheet is displayed by default. Refer to Figure 2.
Configuration Details

Figure 2. Misc Property Sheets

The property sheet and parameters are displayed in the property sheet window. Select a different property sheet by clicking on the appropriate property sheet tab at the top of the window. To return to the DCM main window, click the **OK** button.

Parameter values are modified by selecting the parameter in the property sheet window and selecting (or entering) a new value in the Edit window. Select a parameter by clicking on it. For instructions on modifying parameters, refer to Chapter 3, “Configuration Procedures”.

For additional information about the DCM, including pull-down menus, shortcut icons, and parameter reference information, refer to the DCM Online Help supplied with DCM. The DCM Online Help can be accessed from the Help pull-down menu located on the DCM main window or by pressing the F1 key. To access information about a specific parameter within DCM, highlight the parameter and press the F1 key.
2.2 TDM Bus Parameters

TDM Bus parameters are located on the TDM Bus Configuration property sheet. To access this property sheet, expand the TDM Bus device on the DCM main window and double click on the Bus-0 device. The TDM Bus Configuration property sheet is displayed. Refer to Figure 3.

Note: Do not access the TDM Bus Configuration property sheet when configuring a board device (by double clicking on the board model from the DCM main window). When accessing the property sheet in this way, only a subset of parameters are viewable and they are read-only.

Figure 3. TDM Bus Configuration Property Sheet

The TDM Bus Configuration parameters come in pairs, one for the User Defined value and one for the Resolved value. The User Defined value is the one that you set to change the value. The Resolved equivalent is the configuration parameter value that has been resolved by the system software. The resolved parameter value may not match the one you set through the User Defined parameter. User Defined and the Resolved equivalent parameters can be set in two ways:

Set the parameter to a value of Default

In this case, the value of the User Defined parameter is set to a value of Default and the system software determines the value of the parameter. The actual value is then indicated in the parameter’s Resolved equivalent.

For example, if the **NETREF One FRU (User Defined)** parameter is set to an H.100/H.110 enabled device, and the **Derive Primary Clock From (User Defined)** parameter is set to a
value of Default, then the **Derive Primary Clock From (Resolved)** parameter will be set to NETREF_1.

Set the parameter to a specific value

In this case, the value of the User Defined parameter is set to a specific value. The system software will attempt to configure the system with the parameter when you click the Apply button on the DCM property sheet. If the value can be applied, the Resolved equivalent will be to the same value as the User Defined parameter. If the system cannot be configured with the User Defined value, the system will select another value and display it in the parameter’s resolved equivalent.

For example, if the **Derive Primary Clock From (User Defined)** parameter is set to a value of InternalOscillator, then the **Derive Primary Clock From (Resolved)** parameter will be set to a value of InternalOscillator.

**Note:** If the system software cannot configure the system with the User Defined value, only the Resolved equivalent will indicate the parameter’s true value; the User Defined parameter will remain set to the inapplicable value. Therefore, you must always double-check the resolved equivalent to be sure of the parameter’s true value.

### 2.3 Voice Parameters

This section describes how to adjust parameters in the **Voice.prm** file for frequency shift keying (FSK), signal delay adjustments, and silence compressed record. The **Voice.prm** file is downloaded to all Springware voice boards during the installation and configuration process. The default location for this file is \Program Files\Dialogic\Data.

The following information is included in this section:

- Frequency Shift Keying (FSK)
- Signal Delay
- Silence Compressed Record Feature

#### 2.3.1 Frequency Shift Keying (FSK)

Two-way Frequency Shift Keying (FSK) allows applications to send and receive character or binary data at 1200 bits/second between a server and Analog Display Services Interface (ADSI) compatible devices. The two-way FSK feature supports applications such as off-line e-mail editing and sending FSK caller ID data to a Customer Premises Equipment (CPE) device through an MSI/SC board. For information about adjusting the FSK receiver carrier detect threshold, see Section 3.9, “Adjusting FSK Receiver Carrier Detect Threshold”, on page 30. For information about adjusting the FSK transmit framing parameters, see Section 3.10, “Adjusting Two-Way FSK Transmit Framing Parameters”, on page 30.

#### 2.3.1.1 Adjusting Runtime Volume Control

With analog boards, FSK output volume levels can exceed FCC part 68 specifications. The maximum permitted average volume level is -9.5 dBm for analog boards (D/41JCT-LS) and -13.5 dBm for T1 or E1 network interface boards, in order to have an acceptable margin for
compliance purposes. In the case of analog boards, the default transmit output volume level for FSK is approximately -2 dBm.

In order to maintain overall server output signal level compliance, applications need to attenuate the transmit level by approximately -8 dB to comply with FCC part 68 specifications. This 8 dB attenuation applies universally to analog boards (D/41JCT-LS) as well as T1 or E1 voice processing boards.

To adjust the output volume level in your application, use the `dx_adjsv()` function, which is documented in the *Voice API for Windows Operating Systems Library Reference*. The `dx_adjsv()` function lets applications modify the speed or the volume of playback dynamically. Once the speed or volume level is modified, the new setting holds until `dx_adjsv()` executes again or the system is downloaded again.

The `dx_adjsv()` function uses the Speed and Volume Modification Table to adjust the settings. There are 21 entries that represent different levels of speed or volume. You can specify either an absolute position in this table or a relative position to the current value in the table. You can also toggle between table values. Detailed information about this table is in the *Voice API for Windows Operating Systems Programming Guide*.

**Note:** If the default Speed and Volume Modification Table does not provide enough granularity, you can modify the table with the `dx_setsvmt()` function, which is also documented in the *Voice API for Windows Operating Systems Library Reference*.

### 2.3.2 Signal Delay

Previously, data buffers on Intel® Dialogic® voice boards (called firmware buffers) had a fixed size of 512 bytes. To reduce voice latency in Internet telephony applications, the firmware buffer size is now programmable from 128 to 512 bytes. For details, see Section 3.11, “Setting the Firmware Buffer Size”, on page 31.

Intel Dialogic voice API functions stream voice data between the Intel Dialogic voice board firmware buffers and the telephony application via driver buffers. The size of these driver buffers can be set to any value between 256 bytes and 16 KB. Overall signal delay can be reduced by adjusting both the firmware and driver buffers.

**Note:** When adjusting the buffer sizes, keep the following in mind:

- The driver buffer size must always be at least twice the firmware buffer size.
- Simply reducing the driver buffer size does not guarantee better performance. In fact, if the value is poorly chosen, the exact opposite may result.
- The smaller you make the driver buffer size, the more interrupts are generated to handle the buffers, and consequently, there will be an associated degradation of system performance.
- Therefore, you must choose this value carefully to maximize throughput while minimizing system load.

The speed of the host processor, as well as other concurrent processing, has an impact on how low the buffers can be set.
2.3.2.1 Setting the Driver Buffer Size

Two voice API functions are available to control low latency buffer sizing. The `dx_getparm()` function obtains the current firmware or driver buffer size setting, and the `dx_setparm()` function sets only the driver buffer size.

**Note:** The `dx_setparm()` function cannot be used to set the firmware buffer size parameters (`DXBD_TXBUFSIZE` and `DXBD_RXBUFSIZE`). The only way to set the firmware buffer size parameters is in the download parameter file `Voice.prm` (for details, see Section 3.11, “Setting the Firmware Buffer Size”, on page 31).

Refer to the *Voice API for Windows Operating Systems Library Reference* for more information about these and other voice API functions.

2.3.3 Silence Compressed Record Feature

The Silence Compressed Record (SCR) feature enables a recording with silent pauses eliminated. This results in smaller size recorded files with no loss of intelligibility. The SCR feature is enabled in the `Voice.prm` file which is then downloaded during initialization. You must edit this file and set appropriate values for the SCR parameters for your working environment before initializing the board(s). You cannot enable this feature through the Intel Dialogic voice API.

The `Voice.prm` file is downloaded by default to all voice boards during the installation and configuration process. As such, SCR is available to all voice channels in the system.

The SCR parameters specify the silence threshold, the duration of silence at the end of speech before silence compression begins, the duration of a glitch in the line which does not stop silence compression, and more. Details about the SCR parameters are provided in Chapter 6, “Silence Compressed Record Parameter Reference”. After SCR is enabled in the `Voice.prm` file, SCR is automatically activated through use of voice record functions such as `dx_rec()`.

When the audio level is at or falls below the silence threshold for a minimum duration of time, silence compressed record begins. When a short burst of noise (glitch) is detected, the compression does not end unless the glitch is longer than a specified period of time.

Figure 4 illustrates the use of the SCR parameters.
2.3.3.1 Encoding Algorithms

The following encoding algorithms and sampling rates are supported in silence compressed record:

- 6 kHz and 8 kHz OKI ADPCM
- 8 kHz and 11 kHz linear PCM
- 8 kHz and 11 kHz A-law PCM
- 8 kHz and 11 kHz µ-law PCM

2.3.4 Parameter File Order of Precedence

As a general rule, values in the last parameter file downloaded to the board take precedence.

For information about the order of precedence of the various parameter files, refer to Specification of both COUNTRY and PARAMETERFILE in NT on the Telecom Support Resources web site (http://resource.intel.com/telecom/support/tnotes/tnbyos/winnt/tn192.htm).

2.4 Boards Supported

Table 1 lists the Intel Dialogic Boards supported by this Configuration Guide.
### Table 1. Intel Dialogic Springware PCI Boards

<table>
<thead>
<tr>
<th>Category</th>
<th>Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog</td>
<td>D/4PCIU, D/41JCT-LS, D/120JCT-LS</td>
</tr>
<tr>
<td>BRI</td>
<td>BRI/80-PCI, BRI/160-PCI</td>
</tr>
<tr>
<td>Single Span</td>
<td>D/240JCT-T1, D/480JCT-1T1, D/300JCT-E1-75, D/300JCT-E1-120, D/600JCT-1E1-75, D/600JCT-1E1-120</td>
</tr>
<tr>
<td>Dual Span</td>
<td>D/480JCT-2T1, D/600JCT-2E1-120</td>
</tr>
<tr>
<td>Resource</td>
<td>D/160JCT, D/320JCT</td>
</tr>
<tr>
<td>Voice/PBX Integration</td>
<td>D/42JCT-U, D/82JCT-U</td>
</tr>
<tr>
<td>Fax</td>
<td>VFX/41JCT-LS</td>
</tr>
</tbody>
</table>
This chapter provides detailed procedures for each major step in the configuration process for Intel® Dialogic® Springware PCI boards. Note that some of these configuration procedures may not apply to your specific system configuration. The following topics are discussed:

- Assumptions and Prerequisites .................................................. 23
- Order of Procedures ................................................................. 24
- Starting the Configuration Manager (DCM) .............................. 24
- Modifying DCM Property Sheet Parameters ............................... 25
- Setting the TDM Bus Clock Source ............................................ 27
- Configuring ISDN Protocols ....................................................... 28
- Downloading the Protocol and Country Dependent Parameter File 29
- Configuring Digital Network Interface Parameters .................. 29
- Adjusting FSK Receiver Carrier Detect Threshold ...................... 30
- Adjusting Two-Way FSK Transmit Framing Parameters ............. 30
- Setting the Firmware Buffer Size .............................................. 31
- Enabling Silence Compressed Record on Only One Board .......... 32
- Verifying Device Names ........................................................... 33
- Initializing the System .............................................................. 36
- Reconfiguring the System .......................................................... 37

3.1 Assumptions and Prerequisites

The following assumptions and prerequisites exist regarding the configuration procedures:

- All required software, including prerequisites, have been installed according to the procedures in the Installation Guide supplied with your Intel Dialogic System Release.
- The Intel Dialogic System Release was installed in the default directory C:\Program Files\Dialogic. Command instructions, directories paths and environment variable are shown relative to the default installation directory.
- You must have administrative privileges on the local computer and on any remote computer you connect to in order to use the configuration manager (DCM). Contact your network administrator to set up administrative privileges as required.
- If you are using CAS (T1) or R2 (E1) instead of an ISDN protocol, the Global Call protocols have been installed. Although the procedure for downloading the Global Call protocols is included in this manual, the Global Call protocols are provided in a separately orderable package. For information about obtaining the Global Call Protocol Package, see your Sales
representative. For information about country dependent parameters associated with a protocol, see the Global Call Country Dependent Parameters (CDP) Configuration Guide which is included in the separately orderable Global Call Protocol Package.

- If applicable, TDM bus resources have been reserved for third party boards as described in the DCM online help.

3.2 Order of Procedures

Procedures that are required when initially configuring any system are noted as such. The additional procedures may be required depending on your system. Except for the required procedures, configuration procedures should be performed in the order presented.

1. Starting the configuration manager (DCM) (required)
2. Modifying DCM property sheet parameters
3. Setting the TDM bus clock source
4. Configuring ISDN protocols
5. Downloading Global Call CDP parameters
6. Configuring Digital Network Interface parameters
7. Configuring voice parameters
8. Verifying Device Names
9. Initializing the system (required)
10. Reconfiguring the system

3.3 Starting the Configuration Manager (DCM)

Online Help is available for all parameters accessible through the configuration manager (DCM). To access the help, select Contents from the Help menu. To start the DCM, perform the following steps:

1. From the Windows Start menu, select Programs > Intel Dialogic System Software > Configuration Manager-DCM to launch the configuration manager (DCM). The Computer Name dialog box will appear (Figure 5).

   Note: The Computer Name dialog box displays automatically the first time you run the DCM with the local computer name as the default. If the Computer Name dialog box is not already displayed, you can get it by selecting the File > Connect or by clicking the Connect icon in the DCM main window.
2. Connect to either the local computer or a remote computer as follows:
   • To connect to the local computer, click Connect.
   • To connect to a remote computer, select the Remote radio button, enter the remote computer name, then click Connect. For TCP/IP networks you can enter the IP address instead of the remote computer name.

After you connect to a computer, you will see a message that indicates that boards are being detected, and then the DCM main window. The DCM main window contains a tree structure of the boards installed in your system. Refer to Figure 1, “DCM Main Window”, on page 14). In addition to the DCM main window, a system tray icon is also created. For details about the DCM system tray icon, refer to the DCM Online Help.

3.4 Modifying DCM Property Sheet Parameters

Within the DCM, each board has a set of property sheets that display the board’s configuration parameters, grouped together on tabs according to the type of board functionality that they affect. To change a board’s configuration parameters follow this procedure:

1. Double-click the board model name on the DCM main window to display the board’s property sheets. See Figure 1, “DCM Main Window”, on page 14.

2. Click a property sheet tab to view all of the board parameters associated with a particular property sheet. For example, to view the parameters associated with the System property sheet, click the System tab. The System property sheet and associated parameters are displayed. Refer to Figure 6.
Refer to the DCM Online Help for a description of property sheets and parameters. The DCM Online Help can be accessed from the Help menu in the DCM main window or by pressing the F1 key. To access information about a specific parameter, highlight the parameter in the DCM and press F1 or click the Help button in the lower, right-hand corner of the property sheet.

3. Select a parameter by clicking on it; the selected parameter and its current value are displayed in the Value window at the bottom of the property sheet.

4. In the Value window of the property sheet, select a value from the list or type the parameter value.

5. Click Apply to save the change.

6. Repeat this procedure for all parameters that need to be modified.

7. Click OK to save all your changes and return to the DCM main window.
3.5 Setting the TDM Bus Clock Source

The *default clock source* is the internal oscillator of the Primary Master board. You should derive clocking from a digital network trunk if available, rather than from an internal oscillator. The internal oscillator should be used as the clock source only for internal testing purposes.

1. To access the clocking settings in the DCM, double-click **Bus-0** under TDM Bus in the DCM tree structure of configured devices in the DCM Main Window. Refer to Figure 1, “DCM Main Window”, on page 14. This displays the TDM Bus Configuration property sheet for Bus-0. Refer to Figure 3, “TDM Bus Configuration Property Sheet”, on page 16.

   *Note:* To configure a third-party board installed in your system, refer to the DCM online help.

2. Designate a board as the primary master using the following steps:

   2a. Select the **Primary Master FRU (User Defined)** parameter.
   
   2b. In the Value list box, select the name of the board that will provide the clocking to the bus.
   
   2c. Click **Apply**.

3. If the Primary Master board is deriving system clocking from a digital network trunk connected to a Network Reference (NETREF) board, perform the following actions. Otherwise, if you are using the Primary Master board’s internal oscillator as the clocking source, skip to Step 4.

   3a. Select the **NETREF One FRU (User Defined)** parameter.
   
   3b. In the Value box, type the name of the board that contains the network interface which will provide a network reference clock to the system. The board name that you enter should be the same name as displayed in the DCM main window.
   
   3c. Click **Apply**.
   
   3d. Specify the source of the network reference clock (specifically, the trunk on the board containing the digital network interface providing the clock) via the **Derive NETREF One From (User Defined)** parameter.
   
   3e. Click **Apply**.

4. Configure the Primary Master board to use the correct clock reference by setting the **Derive Primary Clock From (User Defined)** parameter to either NETREF_1 or Internal Oscillator.

5. Click **OK**.

6. To set the clocking for the secondary clock master, perform the following steps:

   6a. Highlight the **Secondary Master FRU (User Defined)** parameter.
   
   6b. In the Value list box, select the board that will provide the clocking to the bus if the primary master fails. The board name that you enter should be the same name as displayed in the DCM main window.
   
   6c. Click **Apply**.
6d. Configure the Primary Master board to use the correct clock reference by setting the Derive Primary Clock From (User Defined) parameter to either NETREF_1 or Internal Oscillator.

6e. Click OK.

Continue with any additional configuration procedures that are applicable to your system. If you need to change additional DCM parameters, see Section 3.4, “Modifying DCM Property Sheet Parameters”, on page 25 for general information about changing DCM parameters. For detailed information about TDM Bus parameters, see Section 4.5, “TDM Bus Configuration Property Sheet”, on page 48.

When you are satisfied with the TDM Bus clock source configuration information, if applicable, proceed with either Section 3.6, “Configuring ISDN Protocols”, on page 28 or Section 3.7, “Downloading the Protocol and Country Dependent Parameter File”, on page 29.

### 3.6 Configuring ISDN Protocols

For T1 or E1 boards using an ISDN protocol, perform the following procedure to configure the ISDN protocol for each T1 or E1 interface.

1. Double-click the board model name on the DCM main window to display the board’s property sheets.

2. Click the Interface tab to display the board parameters associated with the Interface property sheet.

3. With the ISDNProtocol parameter highlighted, click the arrow on the right side of the Value window to display the list of ISDN protocol values.

4. Select a value by scrolling the list and highlighting the desired ISDN protocol.

5. Click Apply.

6. If you are configuring a dual-span board, select the ISDNProtocol2 parameter and repeat Step 3 through Step 5 to select the ISDN protocol for the second span.

7. Click the Misc tab to display the board parameters associated with the Miscellaneous property sheet.

   **Note:** Do not specify a firmware file for the FirmwareFile (or FirmwareFile2) parameter. The firmware file will be downloaded automatically depending on the protocol that you select using the ParameterFile parameter.

8. Select the ParameterFile parameter and then type a file name in the Value box with a file extension of prm. For example, if you selected 4ESS as the value for the ISDNProtocol parameter, you should name the file 4ess.prm.

9. Click Apply.
10. If you are configuring a dual-span board, select the ParameterFile2 parameter and repeat Step 8 and Step 9 for the second span using the same file name.

11. Click OK to save your changes and return to the DCM main window.

3.7 Downloading the Protocol and Country Dependent Parameter File

For T1 boards using the CAS protocol or E1 boards using the R2 protocol, you will need to configure the T1 or E1 interface using the Global Call country dependent parameters.

With Springware boards, the protocol is determined when a Global Call device is opened with the gc_OpenEx() function. For information about using this function, see the Global Call API Library Reference. The protocol name to use in the gc_OpenEx() function is the root file name of the CDP file without the .cdp extension. See the Parameter Configuration chapters in the Global Call Country Dependent Parameters (CDP) Configuration Guide for the gc_OpenEx() protocol name for each protocol.

See the Parameter Configuration chapters in the Global Call Country Dependent Parameters (CDP) Configuration Guide for the Global Call Voice and Network Parameters file name for each protocol.

3.8 Configuring Digital Network Interface Parameters

The digital network interface (DNI) parameter file is an ASCII text file used by the Intel Dialogic System Software to initialize the firmware configuration for the front end of digital network interface Springware boards. The DNI parameter file is named Spandti.prm and is installed in the Data subdirectory of the Intel Dialogic home directory (normally C:\Program Files\Dialogic\Data).

If the default settings in Spandti.prm are not appropriate for your application, you can modify this file or create your own version of this file. In either case, you must enter the name of the file in DCM using the ParameterFile parameter, which appears on the Misc property sheet for Springware boards. Keep a record of the parameter settings that you change. All values are in hexadecimal.

For detailed information about each of the DNI parameters, see Chapter 5, “DNI Parameter Reference”.

For the modified DNI parameters to take effect, specify the name of the file that contains them using the ParameterFile parameter in DCM.
3.9 Adjusting FSK Receiver Carrier Detect Threshold

Host applications can change the receiver carrier detect threshold from the default value (-44 dBm) to any value in the range of -22 dBm to -44 dBm. Values are adjusted in 2 dB intervals with a hysteresis of ±2 dB at each step. Odd numbers are valid values, but they will be rounded up to the next even number; for example, -27 becomes -26.

To edit the Voice.prm file to set the receiver carrier detect threshold, proceed as follows:

1. Open the file \Program Files\Dialogic\Data\Voice.prm using any text editor (for example Windows Notepad).

2. Add parameter 255 and the appropriate value (26 in this example) as shown in bold text in the following example:

   #beginning of voice.prm

   AREA=VOICE
   SIZE=WORD
   BASE=DECIMAL
   PARAM 255 : 26  # set receiver carrier detect threshold
   #end of voice.prm

3. Save the file.

For the added parameter to take effect, run DCM and specify the Voice.prm file as the value for the ParameterFile parameter, which appears on the Misc property sheet for Springware boards.

3.10 Adjusting Two-Way FSK Transmit Framing Parameters

The two-way frequency shift keying (FSK) transmit framing parameters and their respective default values are:

- TX channel seizure bits = 360
- TX onhook mark bits = 180
- TX offhook mark bits = 84
- TX endmark bits = 84
- TX to RX delay time in 10 millisecond units = 5

You may adjust any of these values to be different from their default setting by editing the Voice.prm file. To do this, perform the following:

1. Open the file \Program Files\Dialogic\Data\Voice.prm using any text editor (for example Windows Notepad).

2. Add the following lines shown in bold to the Voice.prm file (example values are provided):
Configuration Procedures

3. Save the file.

For the modified parameters to take effect, run DCM and specify the Voice.prm file as the value for the ParameterFile parameter, which appears on the Misc property sheet for Springware boards.

### 3.11 Setting the Firmware Buffer Size

To edit the Voice.prm file to set the firmware play and record buffer sizes, proceed as follows:

1. Open the file \Program Files\Dialogic\Data\Voice.prm using any text editor (for example Windows Notepad).

2. Add the appropriate play and record parameters as shown in bold text in the example below:

   ```plaintext
   #beginning of voice.prm
   AREA=VOICE
   SIZE=WORD
   BASE=DECIMAL
   . . .
   PARAM 246 : 256  # set firmware play buffer size to 256 bytes
   PARAM 247 : 256  # set firmware record buffer size to 256 bytes
   #end of voice.prm
   ```

3. Save the file.

For the modified parameters to take effect, run DCM and specify the Voice.prm file as the value for the ParameterFile parameter, which appears on the Misc property sheet for Springware boards.

### 3.12 Enabling and Modifying Silence Compressed Record Parameters

As distributed, the silence compressed record (SCR) parameters in the Voice.prm file appear as comments (each line is preceded with #). To enable the silence compressed record feature and edit this file, remove the # from the beginning of each line containing an SCR parameter. Recommended values for the SCR parameters are provided in the file.
3.12.1 Enabling Silence Compressed Record on Only One Board

The silence compressed record feature is enabled in the Voice.prm file. When this file is downloaded during initialization, SCR is enabled on all boards in your system.

To enable SCR on only one board in a multi-board system configuration, perform the following steps:

1. Disable the SCR parameters in the Voice.prm file.

2. Create a new parameter file that contains the SCR parameters, for example, by copying and renaming Voice.prm to Voice_scr.prm, and then edit the SCR parameters in the new parameter file.

3. Download this new parameter file to the desired board by specifying it in DCM with the ParameterFile parameter. See Section 3.4, “Modifying DCM Property Sheet Parameters”, on page 25 for general information about setting parameters in DCM.

For detailed information about SCR parameters, see Chapter 6, “Silence Compressed Record Parameter Reference”.

3.13 Setting AGC Parameters

For environments where AGC fails to set the volume back to normal after a glitch occurs on the line, proceed as follows:

1. Open the file \Program Files\Dialogic\Data\Voice.prm using any text editor (for example Windows Notepad).

2. Add the following AGC parameters as shown in bold text in the example below:
Configuration Procedures

#beginning of voice.prm
AREA=VOICE
SIZE=WORD
BASE=DECIMAL
CountryFeatureSet = DPD
.
PARAM 120 : (DECIMAL WORD) 57147  # decay low
PARAM 121 : (DECIMAL WORD) 127  # decay high
#end of voice.prm

11. Save the file.

For the added parameters to take effect, run DCM and specify the Voice.prm file as the value for the ParameterFile parameter, which appears on the Misc property sheet for Springware boards.

3.14 Verifying Device Names

This section describes how to verify the device names assigned to the boards in your system.

- Device Overview
- Device Types
- Sorting PCI Springware Boards
- Constructing Device Names

3.14.1 Device Overview

The following concepts are key to understanding Intel Dialogic devices:

- **device**
  A computer component controlled through a software device driver. An Intel Dialogic resource board, such as a voice resource, fax resource, and conferencing resource, and network interface board contain one or more logical board devices. Each channel or time slot on the board is also considered a device.

- **device channel**
  A data path that processes one incoming or outgoing call at a time (equivalent to the terminal equipment terminating a phone line). The first two numbers in the product naming scheme identify the number of device channels for a given product. For example, there are 24 voice device channels on a D/240JCT-T1 board, 30 on a D/300JCT-E1.

- **device name**
  A literal reference to a device, used to gain access to the device via an xx_open() function, where “xx” is the prefix defining the device to be opened. The “xx” prefix is “dx” for voice device, “fx” for fax device, “ms” for modular station interface (MSI) device, and so on. For more information on device names, see Section 3.14.4, “Constructing Device Names”, on page 35.

- **physical and virtual boards**
  Intel Dialogic API functions distinguish between physical boards and virtual boards. The device driver views a single physical voice board with more than four channels as multiple emulated D/4x boards. These emulated boards are called virtual boards. For example, a D/120JCT-LS with 12 channels of voice processing contains three virtual boards. A
D/480JCT-2T1 board with 48 channels of voice processing and two T1 trunk lines contains 12 virtual voice boards and two virtual network interface boards.

The Intel Dialogic System Software creates standard device and channel names for boards. These names are input as the namep parameter to, for example, the dx_open() and fx_open() functions, which return the device handles necessary for many essential API calls, such as dx_play() and dx_rec().

When assigning device names, the Intel Dialogic System Software first groups the devices into device types and then sorts the devices within each group. Each group’s sort order depends on what kind of boards are installed in your system. Each device is then named according to its device type (group) sort number.

You can verify the Springware device names assigned to the boards in your system as follows:

1. Go to \Program Files\Dialogic\Cfg. This is the default location for configuration files. You may have specified a different location when installing the Intel Dialogic System Software.


### 3.14.2 Device Types

The Intel Dialogic System Software designates devices as the following types:

- **Voice and fax**. Device names for this type receive the prefix dxxx.
- **Digital network interface**. Device names for this type receive the prefix dti.
- **Modular station interface**, including MSI/80SC, MSI/160SC, and MSI/240SC. Device names for this type receive the prefix msi.
- **Audio conferencing**, including DCB/320, DCB/640, DCB/960. Device names for this type receive the prefix dcb.
- **IP network interface**. Device names for this type are prefixed ipt.
- **IP media** (for example, DM3 IPLink boards). Device names for this type are prefixed ipm.

Voice boards with an integrated digital network interface are assigned both voice devices and one or two digital network interfaces.

### 3.14.3 Sorting PCI Springware Boards

The way in which PCI Springware boards are sorted depends on how the boards’ rotary switches are set.

- Rotary switch settings are unique: The PCI boards are sorted in ascending order of rotary switch setting.
- Rotary switches are set to zero: The PCI boards are sorted in ascending order of bus and slot number.

**Note:** Both of these methods may be used in the same system.
Refer to Table 2 for an example.

### Table 2. Device Sorting Example

<table>
<thead>
<tr>
<th>Sort Order</th>
<th>Board</th>
<th>Address</th>
<th>Rotary Switch</th>
<th>Slot Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VFX/41JCT-LS</td>
<td>N/A</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>D/41JCT-LS</td>
<td>N/A</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>D/240JCT-T1</td>
<td>N/A</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

### 3.14.4 Constructing Device Names

Once the Intel Dialogic System Software sorts the devices, it assigns names to both devices and channels within devices. The following topics discuss how to construct device names:

- **Overview of Device Naming**
- **Board-Level Names**
- **Channel-Level Names**

#### Overview of Device Naming

Although there is a great deal of consistency among different types of compatible Intel Dialogic hardware in how devices are numbered, device mapping (device naming or device numbering) is hardware dependent. If a programmer “hard-codes” an application to use device names based on specific Intel Dialogic boards, some of those device names may need to be changed if a different model board is used as a replacement.

A programmer can achieve the greatest degree of backward compatibility among Intel Dialogic boards by making the device mapping in the application program hardware independent. The method for achieving this, along with sample application code, is provided in the technical note entitled “Identifying the number and type of Intel Dialogic boards in a Windows NT system from within an application,” [http://resource.intel.com/telecom/support/tnotes/tnbyos/winnt/tn193.htm](http://resource.intel.com/telecom/support/tnotes/tnbyos/winnt/tn193.htm). This technical note also is available from the Intel Networking & Communications Telecom Support Resources web site [http://developer.intel.com/design/telecom/support/](http://developer.intel.com/design/telecom/support/) by selecting Technical Notes, and then the operating system, Windows NT.

#### Board-Level Names

A device name is assigned to each device or each component in a board as follows:

- **dxxxBn**, where *n* is the device number assigned in sequential order down the list of sorted voice boards. A device corresponds to a grouping of two or four voice channels.

  For example, a D/240JCT-T1 board supports 24 voice channels; the Intel Dialogic System Software therefore divides the D/240JCT-T1 into six voice devices, each device consisting of four channels. Boards with an E1 interface, such as the D/300JCT-E1, support 30 voice channels; the Intel Dialogic System Software divides the D/300JCT-E1 into seven voice devices consisting of four channels each and one voice device consisting of two voice channels.
• **dcbBn**, where \( n \) is the device number assigned in sequential order down the list of sorted audio conferencing boards. A device corresponds to one DCB board.

• **iptBn**, where \( n \) is the logical board number that corresponds to a NIC or NIC address when using IP technology. These devices are used by the Global Call API.

• **ipmBn**, where \( n \) is the board device number assigned to a media board. These devices are used by the Global Call API and the IP Media Library API.

• **brdBn**, where \( n \) is a physical board name assigned to each board in the system. Given the opaque identifier (AUID) for a board, the **SRLGetPhysicalBoardName()** function can be used to retrieve the physical board name.

### Channel-Level Names

A board device name can be appended with a channel or component identifier. The following channel-level devices are used:

- **dxxxBnCy**: where \( y \) corresponds to one of the voice channels. Examples of channel device names for voice boards are dxxxB1C1 and dxxxB1C2.

- **dtiBnTy**: where \( y \) corresponds to one of the digital time slots. Examples of channel device names for digital network interface boards are dtiB1T1 and dtiB1T2.

- **msiBnCy**: where \( y \) corresponds to one of the conferencing channels.

- **dcbBnDy**: where \( y \) corresponds to one (DCB/320), two (DCB/640), or three (DCB/960) DSP(s).

- **iptBnTy**: where \( y \) corresponds to the logical channel number over which call signaling is transmitted when using IP technology. These devices are used by the Global Call API.

- **ipmBnTy**: where \( y \) corresponds to a media resource on a media board and is used to control media streaming and related functions when using IP technology. These devices are used by the Global Call API and the IP Media Library API.

For a given physical board, devices are enumerated sequentially. For example:

For a Springware D/600JCT board, devices are enumerated as follows:

- dxxxB1C1-dxxxB8C2 (span 1) then
- dxxxB9C1-dxxxB16C2 (span 2)

When you are satisfied with all configuration information, proceed with **Section 3.15, “Initializing the System”**, on page 36.

### 3.15 Initializing the System

The new configuration settings will not take effect until the system is initialized. Before system initialization, make sure you perform all of the necessary configuration procedures. To initialize the system for the first time, proceed as follows:

1. From the DCM main window, select the root of the tree structure (Configured Devices on...) by clicking it.
2. Choose **Device > Enable Device(s)** (or click the Enable Device(s) icon on the DCM toolbar).

3. Choose **System > Start System** (or click the Start all Enabled Devices icon on the DCM toolbar).

4. Verify the system has started (indicated by a status of “Started” in the System Service Status line at the bottom of the DCM main window).

5. After starting the system for the first time, you may want to use some of the tools provided by the system software to verify that your system is operating properly. Look in the Program Files\Dialogic\Demos directory for demo programs.

6. If you have problems, see the Troubleshooting section of the **System Release Administration Guide**. Problems on initial startup are typically caused by errors in your configuration settings.

Once the system is initialized for the first time, the system can be reconfigured and re-initialized as described in **Section 3.16, “Reconfiguring the System”**, on page 37.

### 3.16 Reconfiguring the System

Once the system is initialized for the first time, if you need to modify and re-download the parameters, performing the following in the DCM.

1. Before you stop the system, stop the application ensuring all channels have been closed.

2. Launch the DCM. From the Windows Start menu, select **Programs > Intel Dialogic System Software > Configuration Manager-DCM**. The DCM main window is displayed. Refer to Figure 1, “DCM Main Window”, on page 14.

3. Stop either the complete Intel Dialogic System or a single board, as appropriate:
   - To stop the system, select **System > Stop System** or click the Stop System icon on the DCM main window before changing parameter values. The system is stopped once “Stopped” is displayed on the status line at the bottom of the DCM main window.
   - To stop a single board, select **Device > Stop Device**.

4. Double-click the board model name to display the configuration data property sheets pertaining to the board. Refer to Figure 1, “DCM Main Window”, on page 14.

5. If you wish to restore the board’s DCM parameter settings to their default values, choose **DCM Device > Restore Defaults**. This resets all of the board’s modified parameters to their default values in the DCM.

6. Modify parameters as described in any of the following procedures that apply:
   - **Section 3.5, “Setting the TDM Bus Clock Source”**, on page 27
   - **Section 3.8, “Configuring Digital Network Interface Parameters”**, on page 29
   - **Section 3.4, “Modifying DCM Property Sheet Parameters”**, on page 25
7. When you’re finished changing parameters, restart the Intel Dialogic System or a single boards, as appropriate:

- Start the system by choosing **System > Start System** or clicking the Start System icon on the DCM main window. The system is started once “Started” is displayed on the status line at the bottom of the DCM main window. The firmware and new configuration settings are downloaded once the system is started.
- To start a single board, choose **Device > Start Device**. The firmware and new configuration settings are downloaded to the board once the board is started.

For detailed procedures about reconfiguration and other administrative tasks, see the system release Administration Guide supplied with your software.
This section lists and describes all parameters contained in the configuration manager (DCM). Parameters are grouped by the property sheet on which they reside. DCM property sheets include the following:

- System Property Sheet
- Telephony Bus Property Sheet
- Interface Property Sheet
- Misc Property Sheet
- TDM Bus Configuration Property Sheet
- Country Property Sheet
- Files Property Sheet

Which property sheets and parameters apply depend on which board is highlighted in the DCM main window when you access the property sheets window. To determine which boards a given parameter applies to, look up the entry for the parameter in the Configuration Parameters window of the DCM online help.

### 4.1 System Property Sheet

The System property sheet contains parameters for configuring the way Intel® Dialogic® boards work with your system. The System property sheet includes the following parameters:

- PciID
- PciSlotNumber
- PciBusNumber
- AUID

**PciID**

**Description:** The PciID parameter specifies a board’s rotary-switch setting. The rotary-switch setting for DM3 architecture boards can be the same for all boards in the system if the value is set to 0.

**Values:** 0 to 15 (The default is 0.)

**Guidelines:** Use the PciID parameter default value.
**PciSlotNumber**

**Description:** The PciSlotNumber denotes the number of the PCI slot in which the board is installed.

**Values:** A positive integer or hexadecimal value

**Guidelines:** The PciSlotNumber parameter is set by the system software and should not be changed by the user.

**PciBusNumber**

**Description:** The PciBusNumber parameter indicates the number of the PCI bus on which the board is installed.

**Values:** A positive integer or hexadecimal value

**Guidelines:** The PciBusNumber parameter is set by the system software and should not be changed by the user.

**AUID**

**Description:** The AUID parameter defines the Addressable Unit Identifier (AUID) of the Intel Dialogic board. The AUID is a unique string of numbers that identifies an Intel Dialogic system component with which communications may be initiated. In the context of the DCM, the AUID is a unique identifier for an Intel Dialogic board.

**Values:** A positive integer or hexadecimal value

**Guidelines:** The AUID parameter is read only and cannot be modified by the user.

### 4.2 Telephony Bus Property Sheet

The Telephony Bus property sheet contains parameters for configuring the telephony bus, which connects the Intel Dialogic boards to each another.

- **BusType**
- **PCMEncoding**

**BusType**

**Description:** The BusType parameter specifies the type of expansion bus cable that is connected to the board.

**Values:**

- None: No resource bus cable is connected to the board.
- TDM Bus: This value is required for D/41JCT-LS and VFX/41JCT-LS boards that are not running in standalone mode.
**PCMEncoding**

**Description:** The **PCMEncoding** parameter specifies the Pulse Code Modulation (PCM) encoding method used on the selected board.

**Values:**
- Automatic [default]: The Intel Dialogic board will use mu-law for T1 configured interfaces and will use A-law for E1 configured interfaces.
- ULAW: mu-law encoding is used for all interfaces.
- ALAW: A-law encoding is used for all interfaces.

### 4.3 Interface Property Sheet

The Interface property sheet contains parameters for configuring a board's interface with a digital network.

- **ISDN Protocol**
- **ISDN Protocol2**

**ISDN Protocol**

**Description:** Specifies that the board’s digital network interface should be configured for Integrated Services Digital Network (ISDN) using the selected ISDN protocol. For specifying the ISDN protocol of the second span on boards that have two spans, use the **ISDN Protocol2** parameter.

**Values:**
- NONE [default]: No ISDN protocol is used.
- `<protocol name>`: The name of an ISDN protocol selected from the parameter’s pick-list.

**Guidelines:** For the proper firmware file for an ISDN protocol to be downloaded, the FirmwareFile value must display a blank or “default”.

**Caution:** For E1 or T1 boards that support Continuous Speech Processing (CSP), specifying an ISDN protocol and a CSP firmware file for the same span results in a download failure to that span. The Intel Dialogic System Service will not start.

**ISDN Protocol2**

**Description:** For a board having two spans, specifies that the board’s second digital network interface should be configured for ISDN using the selected ISDN protocol. Specify the ISDN protocol for the first span using the **ISDN Protocol** parameter.
Values:

- NONE [default]: No ISDN protocol is used.
- <protocol name>: The name of an ISDN protocol selected from the parameter’s pick list.

Guidelines: For the proper firmware file for an ISDN protocol to be downloaded, the FirmwareFile2 value must display a blank or “default”.

Caution: For E1 or T1 boards that support Continuous Speech Processing (CSP), specifying an ISDN protocol and a CSP firmware file for the same span results in a download failure to that span. The Intel Dialogic System Service will not start.

4.4 Misc Property Sheet

The Misc property sheet contains miscellaneous parameters that include the following:

- PassiveMode
- BoardEnabled
- BoardPresent
- FirmwareFile
- FirmwareFile2
- ParameterFile
- ParameterFile2
- EC_Resource
- TSFFileSupport
- DisconnectTone
- SerialNumber
- CSP_Enabled
- CSPExtraTimeSlot
- AdministrativeStatus
- OperationalStatus
- Physical State
- PBX Switch

PassiveMode

Description: The PassiveMode parameter specifies whether clocking faults are handled or ignored by the system software.

Note: The PassiveMode parameter is only applicable to the TDM Bus, Bus-0 device. Also, it is the only Misc property sheet parameter applicable to the Bus-0 device.
DCM Parameter Reference

Values:

- True: The system software will not respond to clocking faults.
- False [default]: The system software handles clocking faults (such as, performing clock fallback)

Guidelines: Set `PassiveMode` parameter to False to implement clock fallback support.

BoardEnabled

Description: The `BoardEnabled` parameter applies to all Intel Dialogic boards. This parameter specifies whether or not the Intel Dialogic System Service should download firmware to activate the board. You can use this parameter to temporarily suspend the use of a given board in your system.

Values:

- Yes [default]: Activates board.
- No: Does not activate board.

Guidelines: Setting this parameter to No does not prevent DCM from deleting the configuration data for a board if you remove the board from the system. For more information see the Automatic Adding and Deleting of Board Data topic in the DCM online Help.

BoardPresent

Description: The `BoardPresent` parameter indicates whether or not the board is physically present in the system and was detected by the Intel Dialogic System Software. A value of No is displayed if you enter configuration data for a board that is not in the system or if a board is improperly installed or malfunctioning.

Values:

- Yes: System software located the board in the system.
- No: System software was unable to find the board in the system. This value is reported when you enter configuration data for a board that is not in the system or when a board is improperly installed in the system.

Guidelines: The `BoardPresent` parameter is read only and cannot be modified by the user.

FirmwareFile

Description: Specifies the name of a firmware load file for the system software to download to the board. The firmware file you specify with the `FirmwareFile` parameter takes the place of the file which is normally downloaded. The Intel Dialogic System Software downloads the load file to the board when it downloads firmware. If no value is set for the `FirmwareFile` parameter, the default firmware is downloaded.

Note: The default firmware file is the file specified using the `ISDNProtocol` parameter. If the `ISDNProtocol` parameter is set to NONE, the `spanplus.fwl` file is downloaded.
**FirmwareFile2**

**Description:** Specifies the name of a firmware load file for the system software to download to second span of an applicable board. The firmware file you specify with the **FirmwareFile2** parameter takes the place of the file which is normally downloaded. The Intel Dialogic System Software downloads the load file to the board when it downloads firmware. If no value is set for the **FirmwareFile2** parameter, the default firmware is downloaded.

**Note:** The default firmware file is the file specified using the **ISDNProtocol2** parameter. If the **ISDNProtocol2** parameter is set to NONE, the spanplus.fwl file is downloaded.

**Values:** A valid firmware file name.

**Guidelines:** For Springware boards that support Continuous Speech Processing (CSP), a special firmware file is required. To enable CSP capability for Springware boards, you must explicitly select the CSP firmware file.

**ParameterFile**

**Description:** Specifies the name of a digital network interface parameter file containing firmware initialization data for customizing the board’s digital network interface. For boards that support two digital network interfaces, this file configures the first interface.

**Note:** If you specify a parameter file using **ParameterFile** and also specify a Country parameter file, all parameters in both files will take effect, but those in the **ParameterFile** file will take precedence over those in a country-specific file.

**Values:**

- **spandti.prm:** File containing default settings provided by Intel Dialogic for configuring the board’s digital network interface.
- **<user-defined>:** User’s customized file (**filename.prm**).

**Guidelines:** For details about modifying network interface parameters, see the Working with Network Interface Parameter Files topic in the DCM online Help. Also, see Chapter 6, “Silence Compressed Record Parameter Reference”.

**ParameterFile2**

**Description:** Specifies the name of a digital network interface parameter file containing firmware initialization data for customizing the second digital network interface on a board that supports two digital network interfaces.

**Note:** The parameter file used by the second digital network interface is determined by the **ParameterFile** parameter, unless you override it using the **ParameterFile2** parameter.
Values:

- spandti.prm: File containing default settings provided by Intel Dialogic for configuring the board’s digital network interface.
- <user-defined>: User’s customized file (filename.prm).

Guidelines: For details about modifying network interface parameters, see the Working with Network Interface Parameter Files topic in the DCM online Help. Also, see Chapter 6, “Silence Compressed Record Parameter Reference”.

EC_Resource

Description: Enables the echo cancellation resource (ECR) feature on a supported board. In ECR mode, the voice channel reduces the echo component on an external SCbus time slot signal.

Note: Once this parameter is set to ON, this becomes the new default value for this board.

Values:

- OFF [default]: ECR Feature is not enabled for this board.
- ON: ECR Feature is enabled for this board.

Guidelines: Once the parameter has been enabled, use the dx_listenecr() or dx_listenecrex() function in your application to activate ECR. When a channel is in ECR mode, the following voice operations are unavailable on that channel: play, dial, tone generation, R2MF, and transaction record. For record operations, only 8K PCM is supported.

For boards that support continuous speech processing (CSP), set this parameter to OFF (disabled) and, instead, use the CSPExtraTimeSlot parameter to enable echo cancellation.

TSFFileSupport

Description: Enables support of tone set files (TSF). A TSF is a downloadable file that contains a database of tone sets. Each tone set contains the specific tones a particular PBX uses for dial tone, ringback, busy, disconnect, and reorder.

Values:

- No [default]: Disables support of TSF files.
- Yes: Enables support of TSF files.

Guidelines: Use this parameter in conjunction with the TSFFilename parameter which specifies the path and filename of the TSF.

DisconnectTone

Description: Enables or disables support of Disconnect Tone Supervision. Disconnect Tone Supervision allows Springware voice processing boards to sense a disconnect has occurred at the PBX by listening for the PBX disconnect tone.
Values:
- No [default]: Disables Disconnect Tone Supervision.
- Yes: Enables Disconnect Tone Supervision.

**SerialNumber**

**Description:** Specifies the unique serial number of an Intel Dialogic board.

**Values:** Serial number of selected board.

**Guidelines:** You may not change the `SerialNumber` parameter value; it is set only by the system.

**CSP_Enabled**

**Description:** Read-only parameter that indicates whether this board has Continuous Speech Processing (CSP) enabled.

**Values:**
- YES: CSP feature is enabled for this board.
- NO: CSP feature is not enabled for this board.

**Guidelines:** To use CSP, you must download the correct firmware file to the board. For more information about CSP, see the CSP Firmware Files topic in the DCM online Help.

**CSPExtraTimeSlot**

**Description:** When using CSP, extra time slots must be reserved to send echo-cancelled data over a TDM bus such as the CT bus. When enabled, this parameter causes one extra time slot to be reserved on the TDM bus for each voice channel on a CSP-enabled span or board. Also, when this parameter is set to ON, the CSP feature is enabled.

**Values:**
- OFF [default]: System does not reserve extra time slot for CSP operation. The CSP feature is disabled.
- ON: System reserves an extra time slot for each channel for CSP operation. The CSP feature is enabled.

**Note:** The CSPExtraTimeSlot parameter must be set to ON (enabled) for the D/120JCT-LS board to operate.

**Guidelines:** If you enable CSP for a board, do not enable the board’s `EC_Resource` parameter. Once this parameter is set to ON, this becomes the new default value for this board.

**AdministrativeStatus**

**Description:** The `AdministrativeStatus` parameter indicates the status of the currently selected device.
Values:
- Initial: The software representation of the board is created when the board’s Physical State parameter is In_System_Locked.
- Stopped: The currently selected device is not running
- Started: The currently selected device is running.
- StopPending: The system software is in the process of stopping the currently selected device.
- StartPending: The system software is in the process of starting the currently selected device.
- Disabled: The currently selected device is not started when the system is started.
- Diagnose: Diagnostics are currently being run on the device.

Guidelines: The AdministrativeStatus parameter is read only and cannot be modified by the user.

OperationalStatus

Description: The OperationalStatus parameter indicates the integrity of the currently selected device.

Values:
- Initial: The software representation of the board is created when the board’s Physical State parameter is In_System_Locked.
- Ok: The currently selected device is operating normally.
- Degraded: The currently selected device is operating at a below optimum level.
- Failed: The currently selected device has failed. Use the Windows Event Viewer to determine the nature of the problem.

Physical State

Description: The Physical State parameter indicates the physical state of a board.

Values:
- In_System_Locked: The board is fully installed and recognized by the system.
- Out_Of_System: The board has been physically removed from the system, but not from the registry (DCM database).
- In_System_Unlocked: The board is physically installed, but the handles are in the open position.

Guidelines: The Physical State parameter is read only and cannot be modified by the user.

PBX Switch

Description: Specifies the make and model of the BPX that the PBX integration board interfaces to.
Values:

- Lucent_2_wire: Lucent Definity G3
- Lucent_4_wire: Lucent Definity System 75/85
- Mitel_DNIC_M420: Mitel SX-50
- Mitel_DNIC_M430: Mitel SX 200ML and SX-2000
- Nortel_Meridian_1: Nortel Meridian 1
- Nortel_Norstar: Nortal Norstar
- Siemens_Hicom: Siemens Hicom 150E or 300E
- Siemens_Rohm: Siemens CBX 9000 Series
- Siemens_Rohm_9006: Siemens Rohm 9006

4.5 TDM Bus Configuration Property Sheet

The TDM Bus Configuration property sheet contains parameters for configuring the TDM Bus. User Defined parameters are provided in this section; Resolved equivalent parameters are not listed in this section.

Note: To access the TDM Bus Configuration property sheet, expand the TDM Bus device in the DCM main window, then double click on the Bus-0 device. Do not access the TDM Bus Configuration property sheet when configuring a board device (by double clicking on the board model from the DCM main window). When accessing the property sheet in this way, only a subset of parameters are viewable and they are all read-only.

- Attached to TDM Buses
- TDM Bus Type (User Defined)
- Media Type (User Defined)
- Group One Clock Rate (User Defined)
- Group Two Clock Rate (User Defined)
- Group Three Clock Rate (User Defined)
- Group Four Clock Rate (User Defined)
- Using Compatibility Clocks (User Defined)
- Primary Lines (User Defined)
- Using Primary Master (User Defined)
- Using Secondary Master (User Defined)
- Using NETREF One (User Defined)
- Using NETREF Two (User Defined)
- Primary Master FRU (User Defined)
- Derive Primary Clock From (User Defined)
- Secondary Master FRU (User Defined)
- Derive Secondary Clock From (User Defined)
- NETREF One FRU (User Defined)
- Derive NETREF One From (User Defined)
• NETREF One Clock Rate (User Defined)
• NETREF Two FRU (User Defined)
• Derive NETREF Two From (User Defined)
• NETREF Two Clock Rate (User Defined)
• StartTimeSlot

**Attached to TDM Buses**

**Description:** The Attached to TDM Buses parameter is a read-only parameter that indicates to which TDM bus the currently selected device is attached. This parameter only appears on the TDM Bus Configuration property sheet for individual board devices, not for the Bus-0 device TDM Bus Configuration property sheet.

**Note:** The TDM buses currently available in the system are listed in the DCM Main Window.

**Values:** 0 to 20

**TDM Bus Type (User Defined)**

**Description:** The TDM Bus Type (Resolved/User Defined) parameter determines the bus mode for the currently selected TDM bus.

**Values:**

- Default [default]: The value of this parameter is to be determined by the system software.
- H.100: The mode for the selected bus is H.100.
- H.110: The mode for the selected bus is H.110.

**Guidelines:** Use the TDM Bus Type (User Defined) parameter default value. The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**Media Type (User Defined)**

**Description:** The Media Type (User Defined) parameter determines the encoding method for the currently selected TDM bus.
Values:

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- ALaw: The encoding method is A-law (this is the method that should be used for E1 trunks).
- MuLaw: The encoding method is mu-law (this is the method that should be used for T1 trunks).
- ClearChannel: This value is currently not supported.

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

Group One Clock Rate (User Defined)

Description: The Group One Clock Rate (User Defined) parameter determines the clock rate for the first group of streams, in the first set of streams, in an H.100/H.110 bus. The first set of sixteen streams in the H.100/110 bus is divided into four groups of four streams each. Each group can operate at a different clock speed. (The second set of sixteen streams in the H.100/H.110 bus always operates at 8 MHz).

Values:

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- 2MHz: The first four-stream group operates at 2 MHz.
- 4MHz: The first four-stream group operates at 4 MHz.
- 8MHz: The first four-stream group operates at 8 MHz.

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

Group Two Clock Rate (User Defined)

Description: The Group Two Clock Rate (User Defined) parameter determines the clock rate for the second group of streams, in the first set of streams, in an H.100/H.110 bus. The first set of sixteen streams in the H.100/110 bus is divided into four groups of four streams each. Each group can operate at a different clock speed. (The second set of sixteen streams in the H.100/110 bus always operates at 8 MHz).
Values:

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- 2MHz: The second four-stream group operates at 2 MHz.
- 4MHz: The second four-stream group operates at 4 MHz.
- 8MHz: The second four-stream group operates at 8 MHz.

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

Group Three Clock Rate (User Defined)

Description: The Group Three Clock Rate (User Defined) parameter determines the clock rate for the third group of streams, in the first set of streams, in an H.100/H.110 bus. The first set of sixteen streams in the H.100/110 bus is divided into four groups of four streams each. Each group can operate at a different clock speed. (The second set of sixteen streams in the H.100/110 bus always operates at 8 MHz).

Values:

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- 2MHz: The third four-stream group operates at 2 MHz.
- 4MHz: The third four-stream group operates at 4 MHz.
- 8MHz: The third four-stream group operates at 8 MHz.

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

Group Four Clock Rate (User Defined)

Description: The Group Four Clock Rate (User Defined) parameter determines the clock rate for the fourth group of streams, in the first set of streams, in an H.100/H.110 bus. The first set of sixteen streams in the H.100/110 bus is divided into four groups of four streams each. Each group can operate at a different clock speed. (The second set of sixteen streams in the H.100/110 bus always operates at 8 MHz).
DCM Parameter Reference

Values:
- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- 2MHz: The fourth four-stream group operates at 2 MHz.
- 4MHz: The fourth four-stream group operates at 4 MHz.
- 8MHz: The fourth four-stream group operates at 8 MHz.

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

Using Compatibility Clocks (User Defined)

Description: The Using Compatibility Clocks (User Defined) parameter indicates whether the compatibility clock is used.

Values:
- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- Yes: The compatibility clock is in use.
- No: The compatibility clock is not in use.

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

Primary Lines (User Defined)

Description: The Primary Lines (User Defined) parameter determines whether the Primary Line is Line A or Line B. The line that is not selected as the Primary Line serves as the Secondary Line.

Values:
- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- A: The primary line is Line A.
- B: The primary line is Line B.

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.
**Using Primary Master (User Defined)**

**Description:** The Using Primary Master (User Defined) parameter indicates whether or not the device specified by the Primary Master FRU parameter is the Clock Master for the currently selected bus. Use this parameter to take the Primary Master FRU offline in the event that it needs to be replaced.

**Values:**

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- No: The device specified by the Primary Master FRU parameter is not the Clock Master for the currently selected bus. This value is set by the system for a short period when the Primary Master FRU fails and the Secondary Master FRU is being promoted to bus master. Otherwise, this parameter cannot have the value No when the system is running.
- Yes: The device specified by the Primary Master FRU parameter is the Clock Master for the currently selected bus.

**Guidelines:** The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**Using Secondary Master (User Defined)**

**Description:** The Using Secondary Master (User Defined) parameter indicates whether or not the device specified by the Secondary Master FRU parameter is the Clock Master for the currently selected bus.

**Values:**

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- No: The device specified by the Primary Master FRU parameter is not the Clock Master for the currently selected bus. This value is set by the system for a short period when the Primary Master FRU fails and the Secondary Master FRU is being promoted to bus master. Otherwise, this parameter cannot have the value No when the system is running.
- Yes: The device specified by the Secondary Master FRU parameter is the Clock Master for the currently selected bus.

**Guidelines:** The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**Using NETREF One (User Defined)**

**Description:** The Using NETREF One (User Defined) parameter determines whether or not NETREF_1 is used as the source of clocking for the current Clock Master. This parameter enables you to temporarily disconnect the network interface that drives NETREF_1 (as determined by the Derive NETREF One From parameter).
Values:

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- No: NETREF_1 is not in use. (Derive NETREF One From (Resolved) and NETREF One FRU (Resolved) parameters are both set to NotApplicable.)
- Yes: NETREF_1 is in use. (Derive NETREF One From (Resolved) is set to the value specified by Derive NETREF One From (User Defined) and NETREF One FRU (Resolved) is set to the value specified by NETREF One FRU (User Defined).

Guidelines: If this parameter is set to Yes, Derive NETREF One From (Resolved) is set to the value specified by Derive NETREF One From (User Defined) and NETREF One FRU (Resolved) is set to the value specified by NETREF One FRU (User Defined).

The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**Using NETREF Two (User Defined)**

Description: The Using NETREF Two (User Defined) parameter determines whether or not NETREF_2 is used as the source of clocking for the current Clock Master. This parameter enables you to temporarily disconnect the network interface that drives NETREF_2 (as determined by the Derive NETREF Two From parameter).

Values:

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- No: NETREF_2 is not in use. (Derive NETREF Two From (Resolved) and NET REF Two FRU (Resolved) parameters are both set to NotApplicable.)
- Yes: NETREF_2 is in use. (Derive NETREF Two From (Resolved) is set to the value specified by Derive NETREF Two From (User Defined) and NETREF Two FRU (Resolved) is set to the value specified by NETREF Two FRU (User Defined)).

Guidelines: If this parameter is set to Yes, Derive NETREF Two From (Resolved) is set to the value specified by Derive NETREF Two From (User Defined) and NETREF Two FRU (Resolved) is set to the value specified by NETREF Two FRU (User Defined).

The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**Primary Master FRU (User Defined)**

Description: The Primary Master FRU (User Defined) parameter identifies the field replaceable unit (FRU) or technology that drives the clocking line specified by the Primary Lines parameter.
Values:

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- <device name>: Name of the device (board) that drives the TDM Bus clocking.

**Derive Primary Clock From (User Defined)**

**Description:** The Derive Primary Clock From (User Defined) parameter specifies the clock source that the Primary Master FRU uses to drive the Primary Line.

**Values:**

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- InternalOscillator: The Primary Master derives clocking from its own circuitry.
- NETREF_1: The Primary Master derives clocking from NETREF_1.
- NETREF_2: The Primary Master derives clocking from NETREF_2.

**Guidelines:** The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**Secondary Master FRU (User Defined)**

**Description:** The Secondary Master FRU (User Defined) parameter specifies the FRU or technology that drives clocking for the secondary line.

**Values:**

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- <device name>: Device name of an the H.100/H.110-enabled FRU.

**Guidelines:** The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**Derive Secondary Clock From (User Defined)**

**Description:** The Derive Secondary Clock From (User Defined) parameter specifies the clock source that the Secondary Master FRU uses to drive the Secondary Line.
Values:

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- InternalOscillator: The Secondary Master derives clocking from its own circuitry.
- NETREF_1: The Secondary Master derives clocking from NETREF_1.
- NETREF_2: The Secondary Master derives clocking from NETREF_2.

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**NETREF One FRU (User Defined)**

**Description:** The NETREF One FRU (User Defined) parameter identifies the FRU containing the interface to the network line that drives NETREF_1.

**Values:**

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- <device name>: Device name of an the H.100/H.110-enabled FRU.

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**Derive NETREF One From (User Defined)**

**Description:** The Derive NETREF One From (User Defined) parameter specifies the network interface that determines the clocking for the NETREF_1 line. The indicated interface is located on the FRU designated by the NETREF One FRU parameter.

**Values:**

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- NetworkInterfaceOne: NETREF_1 is derived from interface 1 on the FRU designated by the NETREF One FRU parameter.
- NetworkInterfaceTwo: NETREF_1 is derived from interface 2 on the FRU designated by the NETREF One FRU parameter.
- NetworkInterfaceThree: NETREF_1 is derived from interface 3 on the FRU designated by the NETREF One FRU parameter.
- NetworkInterfaceFour: NETREF_1 is derived from interface 4 on the FRU designated by the NETREF One FRU parameter.

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For
more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**NETREF One Clock Rate (User Defined)**

**Description:** The NETREF One Clock Rate (User Defined) parameter determines the clock rate for the NETREF_1 line.

**Values:**
- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- 8KHz
- 1.536MHz
- 1.544MHz
- 2.048MHz

**Guidelines:** The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**NETREF Two FRU (User Defined)**

**Description:** The NETREF Two FRU (User Defined) parameter identifies the FRU containing the interface to the network line that drives NETREF_2.

**Values:**
- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- `<device name>`: Device name of an the H.100/H.110-enabled FRU.

**Guidelines:** The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**Derive NETREF Two From (User Defined)**

**Description:** The Derive NETREF Two From (User Defined) parameter specifies the network interface that determines the clocking for the NETREF_2 line. The indicated interface is on the FRU designated by the NETREF Two FRU parameter.
Values:

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- NetworkInterfaceOne: NETREF_2 is derived from interface 1 on the FRU designated by the NETREF Two FRU parameter.
- NetworkInterfaceTwo: NETREF_2 is derived from interface 2 on the FRU designated by the NETREF Two FRU parameter.
- NetworkInterfaceThree: NETREF_2 is derived from interface 3 on the FRU designated by the NETREF Two FRU parameter.
- NetworkInterfaceFour: NETREF_2 is derived from interface 4 on the FRU designated by the NETREF Two FRU parameter.

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**NETREF Two Clock Rate (User Defined)**

Description: The NETREF Two Clock Rate (User Defined) parameter determines the clock rate for the NETREF_2 line.

Values:

- Default [default]: The value of this parameter is to be determined by the system software. Its current value is indicated by the Resolved Equivalent.
- 8KHz
- 1.536MHz
- 1.544MHz
- 2.048MHz

Guidelines: The value you set for this parameter may not be accepted by the system software. To determine the value that the system will use, check the value of the Resolved Equivalent. For more information about the distinction between User Defined and Resolved parameters, see the User Defined and Resolved Parameters topic in the DCM online Help.

**StartTimeSlot**

Description: This parameter is not currently supported.

4.6 **Country Property Sheet**

The Country property sheet contains parameters which enable you to configure Intel Dialogic boards for use in specific countries. The Country parameters include:

- Country
- Protocol
• Digital Signaling
• Analog Signaling
• DTMF Transmit Level
• Receive Gain
• Frequency Resolution
• Dial Pulse Detection
• Outbound Pulse

Country

Description: Determines the country for which you are setting the Country parameters. For

Values: See the Country Parameter Selection Table in the DCM online Help.

Note: The parameters displayed on the Country property sheet are limited to those which are available for the country selected using the Country parameter. However, not all parameters displayed apply to all boards. To determine which boards specific Country parameters apply to, see the Country Parameter Selection Table in the DCM online Help.

Guidelines: If you specify a parameter file using the ParameterFile parameter and also specify a Country parameter file, all parameters in both files will take effect, but those in the ParameterFile will take precedence over those in the country-specific file.

Protocol

Description: Specifies the protocol for service to an E1 interface.

Values:

• PROT_BTCALLSTREAM [default]: selects BT Callstream protocol.
• PROT_MERCURYCAS: Selects Mercury CAS protocol.

Guidelines: To use this parameter, you must also set a value for the Country parameter. Consult the Country Parameter Selection Table in the DCM online Help to verify that the value you choose for this parameter can be used for the country selected.

Digital Signaling

Description: Allows you to designate time slot 16 for signaling or to choose channel-associated signaling.

Values:

• TS16_SIG [default]: Designates time slot 16 to be used for signaling.
• TS16_CLEAR: Selects channel-associated signaling.

Guidelines: To use this parameter, you must also set a value for the Country parameter. Consult the Country Parameter Selection Table in the DCM online Help to verify that the value you choose for this parameter can be used for the country selected.
Analog Signaling

Description: Specifies whether to use earth recall signaling or hookflash signaling. Several European countries employ earth recall signaling.

Values:
- SIG_HF: Use hookflash signaling.
- SIG_ER: Use earth recall signaling.

Guidelines: To use this parameter, you must also set a value for the Country parameter. To be certain that the value you set with this parameter can be applied to the board you are using, consult the Country Parameter Selection Table in the DCM online Help.

DTMF Transmit Level

Description: Specifies the desired dual tone multi-frequency (DTMF) output level in dBm.

Values:
- CEPT1 [default]: -11dBm Lo-tone, -9 dBm Hi tone
- CEPT2: -8 dBm Lo-tone, -6 dBm Hi tone

Guidelines: CEPT1 levels are CTR-21 compliant. CEPT2 levels are not CTR-21 compliant, but may be required in certain situations.

Receive Gain

Description: Defines the amount that the loop start interface boosts or attenuates the incoming analog signal.

Values:
- RXGAIN_0 [default]: Set the receive gain to 0 db.
- RXGAIN_P3: Set the receive gain to +3 db
- RXGAIN_P2: Set the receive gain to +2 db
- RXGAIN_P1: Set the receive gain to +1 db
- RXGAIN_N3: Set the receive gain to -3 db
- RXGAIN_N2: Set the receive gain to -2 db
- RXGAIN_N1: Set the receive gain to -1 db

Guidelines: To use this parameter, you must also set a value for the Country parameter. Consult the Country Parameter Selection Table in the DCM online Help to verify that the value you choose for this parameter can be used for the country selected.

Frequency Resolution

Description: Specifies the difference between each tone of a dual-tone signal. This parameter applies when Global Tone Detection is used.
DCM Parameter Reference

Values:

- FREQRES_HIGH [default]: Sets the frequency resolution to 62.5 Hz.
- FREQRES_LOW: Sets the frequency resolution to 125 Hz.

Guidelines: In most cases, you can use the high-resolution default of 62.5 Hz. In other cases you may want to select the 125 Hz resolution to match any boards in your system that use the lower resolution.

Note: To use this parameter, you must also set a value for the Country parameter. Consult the Country Parameter Selection Table in the DCM online Help to verify that the value you choose for this parameter can be used for the country selected.

Dial Pulse Detection

Description: Enables Intel Dialogic boards to detect pulse dialing. The country to which dial pulse detection applies depends on the value of the Country parameter.

Values:

- DPD_NONE [default]: Deactivates dial pulse detection. No Dial Pulse Detection parameters are specified.

Guidelines: To use this parameter, you must also set a value for the Country parameter. To be certain that the value you set with this parameter can be used for the country and board you selected, consult the Country Parameter Selection Table in the DCM online Help.

Outbound Pulse

Description: Allows you to select the number of outbound pulses dialed per second.

Values:

- PPS_10 [default]: Sets the number of outbound pulses to 10 pulses per second (PPS).
- PPS_20: Sets the number of outbound pulses to 20 PPS.

Guidelines: Rotary telephones in some Asian countries use dial pulse instead of loop pulse dialing. Dial pulse dialing may operate at 10 or 20 PPS. The default outbound pulse dialing rate is 10 PPS. Ensure that you selection matches the protocol of the lines that will connect to your system.

Note: To use this parameter, you must also set a value for the Country parameter. Consult the Country Parameter Selection Table in the DCM online Help to verify that the value you choose for this parameter can be used for the country selected.
4.7 Files Property Sheet

The Files property sheet contains a parameter for defining downloadable Tone Set Files.

**TSFFileName**

**Description:** Specifies the path and filename of the Tone Set File (TSF) that is to be downloaded to the specified Springware voice board. A TSF is a database of tone sets containing a list of PBX types with their associated tone definitions.

**Values:** A valid path and filename.

**Guidelines:** Use this parameter in conjunction with the TSFFileSupport parameter which enables support for the TSF.
This section lists and describes the Digital Network Interface (DNI) parameters contained in the `Spandti.prm` file. The parameters are organized in the order in which they appear in the file. DNI Parameters include the following:

- Receive Wink Definition .................................................. 64
- Transmit National and International Bits ............................... 64
- Transmit Extra Bits ......................................................... 64
- Initial Signaling Insertion Pattern ...................................... 64
- Signaling Mode .............................................................. 65
- Idle Mode ........................................................................... 65
- Transmit Idle Pattern ....................................................... 65
- Transmit Wink Definition .................................................. 66
- Transmit Pulse Digit Make/Break State Definition .................. 66
- Number of Pulses Per Digit ................................................ 67
- CRC Enable Switch ................................................................ 67
- Receive Pulse Digit Definition ............................................. 67
- Line Length ......................................................................... 68
- CCS16 (Clear Channel Time Slot 16) ..................................... 68
- ESF Framing ........................................................................ 69
- ESF Framing ........................................................................ 69

The DNI parameter file is an ASCII text file used by the Intel® Dialogic® System Software to initialize the firmware configuration for the front end of Springware digital network interface boards. The DNI parameter file is named `Spandti.prm` and is installed in the `Data` subdirectory of the Intel Dialogic home directory (normally `C:\Program Files\Dialogic\Data`).

If the default settings in `Spandti.prm` are not appropriate for your application, you can modify this file and create a new version of this file. In either case, you must enter the name of the file in DCM using the `ParameterFile` parameter, which appears on the Misc property sheet for Springware boards.

All of the `Spandti.prm` parameter values are in hexadecimal.

For the modified DNI parameters to take effect, you will need to specify the name of the file that contains them using the `ParameterFile` parameter in DCM.
Receive Wink Definition

**Number:** 0005

**Description:** Defines which bit will be examined to detect a wink received from the network and the polarity of the transition to be considered a wink.

**Values:**
- 01H: detect wink on A bit (lower nibble)
- 02H: detect wink on B bit (lower nibble)
- 04H: Detect wink on C bit (lower nibble) (E1 only)
- 08H: Detect wink on D bit (lower nibble) (E1 only)
- 10H: Positive polarity (off-on followed by on-off transition) (upper nibble)
- 00H: Negative polarity (on-off followed by off-on transition) (upper nibble)

**Guidelines:** Only one bit may be defined in each nibble. The default value for T1 is 11h (detect wink with positive polarity on A bit). The default value for E1 is 01h (detect wink with negative polarity on A bit).

Transmit National and International Bits

**Number:** 0006

**Description:** Defines the National and International signaling to be carried in time slot 0 of the odd frames in an E1 multiframe. Bit 1 is the International Bit and bits 4 through 8 are the National Bits.

**Values:** An 8-bit byte expressed in hexadecimal.

**Guidelines:** The default data value is 7Fh (all National bits and the International bit set to 1).

Transmit Extra Bits

**Number:** 0007

**Description:** Defines the value of the spare bits in time slot 16 of frame 0 in an E1 multiframe. This is the MultiFrame Alignment Signal (MFAS).

**Values:** An 8-bit byte expressed in hexadecimal.

**Guidelines:** The default value is 07h (all spare bits set to 1).

Initial Signaling Insertion Pattern

**Number:** 0008

**Description:** Defines the default contents of the transmit signaling buffer for all channels. The transmit signaling on a channel will reflect the contents of the transmit signaling buffer for that channel when the channel is set to the signaling insert mode.
Values: The masks to set the corresponding signaling bits on are:

- 01H: A signaling bit
- 02H: B signaling bit
- 04H: C signaling bit (E1 only)
- 08H: D signaling bit (E1 only)

Guidelines: For T1, the default value is 00h (A and B bits are 0). For E1, the default value is 0Bh (A, B, and D bits are 1; C bit is 0) (blocking).

**Signaling Mode**

Number: 0009

Description: Defines the default signaling mode.

Values:

- 01H: Transparent mode (Default for T1)
- 00H: Insertion mode (Default for E1)

Guidelines: Transparent mode is used when the signaling from the TDM bus is transmitted to the T1 or E1 line. Insertion mode is used when the interface controls the signaling to the T1 or E1 line.

**Idle Mode**

Number: 000A

Description: Defines whether the T1 or E1 interface should transmit the idle pattern by default.

Values:

- 00H [default]: Do not transmit the idle pattern.
- 01H: Transmit the idle pattern.

Guidelines: If set to Do not transmit idle, data from the TDM bus is transmitted to the T1 or E1 line. If set to Transmit idle, the idle pattern is transmitted to the T1 or E1 line.

**Transmit Idle Pattern**

Number: 000B

Description: Defines the pattern to be used when the interface is transmitting the idle pattern to the T1 or E1 line.
Values:
- 00H [default]: An idle pattern of 7Fh will be transmitted if interface is T1; an idle pattern of 54h will be transmitted if interface is E1.
- 01H: An idle pattern of FFh will be transmitted if interface is T1; an idle pattern of D5h will be transmitted if interface is E1.

Guidelines: The default value for both T1 and E1 is 00H.

Transmit Wink Definition

Number: 000C

Description: Defines the state of the signaling bits used to transmit a wink. A wink starts by transmitting signaling state 0 for the pre-wink delay time. Then signaling state 1 is transmitted for the wink length time before returning to signaling state 0.

Values:
- 01H: State 0 on A signaling bit (lower nibble)
- 02H: State 0 on B signaling bit (lower nibble)
- 04H: State 0 on C signaling bit (lower nibble) (E1 only)
- 08H: State 0 on D signaling bit (lower nibble) (E1 only)
- 10H: State 1 on A signaling bit (upper nibble)
- 20H: State 1 on B signaling bit (upper nibble)
- 40H: State 1 on C signaling bit (upper nibble) (E1 only)
- 80H: State 1 on D signaling bit (upper nibble) (E1 only)

Guidelines: When a data bit is set, the corresponding signaling bit is ON (1) in the signaling state. For T1, the default value is 01h (A bit toggles from OFF to ON to OFF, B bit remains OFF). For E1, the default value is 89h (A bit toggles from ON to OFF to ON, B and C bits remain OFF, and D bit remains ON).

Transmit Pulse Digit Make/Break State Definition

Number: 000D

Description: Defines the signaling bit states used to transmit a pulse digit. A pulse digit consists of a series of pulses from a make signaling state to a break signaling state.
Values:

- 01H: Make state A signaling bit (lower nibble)
- 02H: Make state B signaling bit (lower nibble)
- 04H: Make state C signaling bit (lower nibble) (E1 only)
- 08H: Make state D signaling bit (lower nibble) (E1 only)
- 10H: Break state A signaling bit (upper nibble)
- 20H: Break state B signaling bit (upper nibble)
- 40H: Break state C signaling bit (upper nibble) (E1 only)
- 80H: Break state D signaling bit (upper nibble) (E1 only)

Guidelines: When a data bit is set, the corresponding signaling bit is ON (1) in the signaling state. For T1, the default value is 01h (A bit pulses from On to OFF to ON, B bit remains OFF). For E1, the default value is 98h (A bit pulses from OFF to ON to OFF, B and C bits remain OFF, and D bit remains ON).

**Number of Pulses Per Digit**

Number: 000E

Description: Defines the number of pulses in each digit dialed.

Values:

- 00H [default]: Digits 1 through 9 are represented by the corresponding number of pulses and digit 0 is represented by 10 pulses.
- 01H: Digits 0 through 9 are represented by the corresponding number of pulses +1 pulse.

Guidelines: The default value is 00H.

**CRC Enable Switch**

Number: 000F

Description: For E1 interfaces, turns the transmission of the CRC-4 pattern on (enabled) or off (disabled) and searches for such a pattern in the received signal.

Values:

- 00H [default]: Disable transmission of the CRC-4 pattern.
- 01H: Enable transmission of the CRC-4 pattern.

Guidelines: The default value is 00H.

**Receive Pulse Digit Definition**

Number: 0011

Description: Defines which bit will be examined to detect a pulse digit received from the network and the polarity of the transition to be considered a pulse.
Values:

- 01H: detect digit on A bit (lower nibble)
- 02H: detect digit on B bit (lower nibble)
- 04H: Detect digit on C bit (lower nibble) (E1 only)
- 08H: Detect digit on D bit (lower nibble) (E1 only)
- 00H: Positive polarity (off → on followed by on-off transition) (upper nibble)
- 10H: Negative polarity (on-off followed by off-on transition) (upper nibble)

Guidelines: Only one bit may be defined in each nibble. The default value for T1 is 11h (detect digit with negative polarity on A bit). The default value for E1 is 01h (detect digit with positive polarity on A bit).

Line Length

Number: 0012

Description: Defines output waveform template based on length of cable being driven for T1 interface.

Values:

- 00H [default]: 000 - 110 feet
- 01H: 110 - 220 feet
- 02H: 330 - 440 feet
- 03H: 220 - 330 feet
- 04H: Square template
- 05H: > 655 feet
- 06H: 440 - 550 feet
- 07H: 550 - 660 feet

Guidelines: The default value is 00H (000 - 110 feet)

CCTS16 (Clear Channel Time Slot 16)

Number: 0013

Description: Defines whether time slot 16 of an E1 multiframe will be used for signaling or for data (clear channel).

Values:

- 00H [default]: Time slot 16 is to be used for E1 signaling.
- 01H: Time slot 16 is defined as a clear channel and will be used to carry data.

Guidelines: The default is to use time slot 16 for signaling.
ESF Framing

Number: 0014

Description: Defines whether D4 Superframe or Extended Superframe (ESF) framing will be used in a T1 interface. D4 Superframe format uses 12 frames and ESF framing uses 24.

Values:
- 00 [default]: Superframe format will be used.
- 01: ESF framing will be used.

Guidelines: The default is D4 Superframe.

Zero Code Suppression

Number: 0020

Description: Specifies the type of zero code suppression to be used for a T1 interface.

Values:
- 00H [default]: No zero code suppression will be used.
- 01H: B8ZS - Binary eight zero code suppression will be used.
- 02H: Bit 7 jamming will be used for zero code suppression

Guidelines: The default is for no zero code suppression to be used.
This section lists and describes the Silence Compressed Record (SCR) parameters contained in the `Voice.prm` file. The SCR parameters include:

- **SCR_T Trailing Silence**
- **SCR_PC PreCompensation**
- **SCR_THRES Silence Threshold**
- **SCR_DG DeGlitch**
- **SCR_ON**

As distributed, the SCR parameters in the `Voice.prm` file appear as comments (each line is preceded with #). To enable the SCR feature and edit this file, remove the # from the beginning of each line containing the SCR parameter. The recommended values for the SCR parameters are provided in the file.

**SCR_T Trailing Silence**

**Description:** The time, in 10-millisecond units, that silence can trail the end of speech before silence compression begins.

**Values:** Time in 10-millisecond units

**Guidelines:** The default value is 100 units (1 second).

**SCR_PC PreCompensation**

**Description:** The number of bytes of Silence Compressed Record pre-compensation.

**Values:** The default is 512 bytes.

**SCR_THRES Silence Threshold**

**Description:** Defines the silence threshold. When the audio level is at or below this threshold for a time defined by the **SCR_T** parameter, silence compression begins.

**Values:** The default is -43 dB.
**SCR DG DeGlitch**

**Description:** Defines the length of time in 10-millisecond units that a burst of noise (glitch) can last before it is not considered noise.

**Values:** Time in 10-millisecond units

**Guidelines:** The default is 4 (40 milliseconds).

**SCR_ON**

**Description:** Defines whether Silence Compressed Record feature is enabled or disabled.

**Values:**
- 1 [default]: SCR is enabled.
- 0: SCR is disabled.
Index

A
accessing property sheets 14
adjusting FSK receiver carrier detect threshold 30
adjusting FSK transmit framing parameters 30
AdministrativeStatus parameter 46
AGC parameters
  setting 32
Analog Signaling parameter 60
Attached to TDM Buses parameter 49
AUID parameter 40

B
Board monitoring frequency in seconds parameter 43
BoardEnabled parameter 43
board-level device names 35
BoardPresent parameter 43
buffer size, driver 19
BusType parameter 40

C
CCTS16 (Clear Channel Time Slot 16) parameter 68
channel
  definition 33
channel-level device names 36
clock source
  setting TDM bus 27
Computer Name Dialog box 25
configuration
  DCM property sheet parameters 25
  DNI parameters for Springware boards 29
configuration assumptions 23
configuration manager
  starting 24
configuration manager  See DCM 13
configuring ISDN protocols 28
configuring third party boards 27
connecting to a computer 25
constructing device names 35
country dependent parameter file
  downloading 29
Country parameter 59
Country property sheet 58
CRC Enable Switch parameter 67
CSP_Enabled parameter 46
CSPExtraTimeSlot parameter 46
CTBus parameters  See TDM Bus parameters

D
DCM 13
  See also property sheets
    connecting to a computer 25
    main window 14
    Online Help 15
    property sheet parameters 25
    starting 24
    starting the GUI 24
DCOM 25
default settings, restoring 37
Derive NETREF One From (User Defined) parameter 56
Derive NETREF Two From (User Defined) parameter 57
Derive Primary Clock From (User Defined) parameter 55
Derive Secondary Clock From (User Defined) parameter 55
device
  definition 33
  handle for 33
  types 34
device name
  board-level 35
  channel-level 36
  constructing 35
  definition 33
  overview 35
  verifying 33
device types 33
Dial Pulse Detection parameter 61
digital network interface 29
digital network interface parameters
  configuring 29
Digital Signaling parameter 59
DisconnectTone parameter 45
DNI
  parameter file 29
downloading protocol and country dependent parameter file 29
driver buffer size 19
DTMF Transmit Level parameter 60

E
EC_Resource parameter 45
ESF Framing parameter 69

F
FCDFileName parameter 43, 44
firmware buffer size
setting 31
FirmwareFile parameter 43
FirmwareFile2 parameter 44
Frequency Resolution parameter 60
frequency shift keying (FSK) adjustments 17
FSK 17
FSK receiver carrier detect threshold
adusting 30
FSK transmit framing parameters
adjusting 30

G
Group Four Clock Rate (User Defined) parameter 51
Group One Clock Rate (User Defined) parameter 50
Group Three Clock Rate (User Defined) parameter 51
Group Two Clock Rate (User Defined) parameter 50

H
help See Online Help

I
Idle Mode parameter 65
Initial Signaling Insertion Pattern parameter 64
initializing the system 36
Interface property sheet 41
ISDN Protocol parameter 41
ISDN Protocol2 parameter 41
ISDN protocols
configuring 28

L
Line Length parameter 68

M
main window, DCM 14
Media Type (User Defined) parameter 49
Misc property sheet 15, 42
modifying DCM parameters 15, 25

N
NETREF One Clock Rate (User Defined) parameter 57
NETREF One FRU (User Defined) parameter 56
NETREF Two Clock Rate (User Defined) parameter 58
NETREF Two FRU (User Defined) parameter 57
Network property sheet 26
Number of Pulses Per Digit parameter 67

O
Online Help 15
OperationalStatus parameter 47
order of procedures 24
Outbound Pulse parameter 61

P
parameter files
order of precedence 20
ParameterFile parameter 44
ParameterFile2 parameter 44
parameters
See also property sheets, CONFIG file
modifying DCM 15, 25
PassiveMode parameter 42
PciBusNumber parameter 40
PciID parameter 39
PCISlotNumber parameter 40
PciSlotNumber parameter 40
PCMEncoding parameter 41
physical board
definition 33
Physical State parameter 47
prerequisites to configuration 23
Primary Lines (User Defined) parameters 52
Primary Master FRU (User Defined) parameter 54
procedures
order of 24
property sheet
Misc 15
property sheets
   accessing  14
   Country  58
   Interface  41
   Misc  42
   Network  26
   System  39
   TDM Bus Configuration  16, 48
   Telephony Bus  40

protocol
   downloading  29
   Protocol parameter  59

R
Receive Gain parameter  60
Receive Pulse Digit Definition parameter  67
Receive Wink Definition parameter  64
reconfiguring the system  37
ReplyMsgTimeout parameter  44
Resolved TDM Bus parameters  16
restoring default settings  37
runtime volume control, adjusting  17

S
SCR  19
SCR_DG DeGlitch parameter  72
SCR_ON parameter  72
SCR_PC PreCompensation parameter  71
SCR_T Trailing Silence parameter  71
SCR_TRHES Silence Threshold parameter  71
Secondary Master FRU (User Defined) parameter  55
SerialNumber parameter  46
setting AGC parameters  32
setting firmware buffer size  31
setting TDM bus clock source  27
signal delay adjustments  18
Signaling Mode parameter  65
silence compressed record  19
   enabling on only one board  32
   encoding algorithms  20
   parameters
      enabling  31
silence compressed record parameters
   modifying  31
sortiing PCI Springware boards  34
spandti.prm file
   modifying  29
starting DCM  24
starting, the system or board  38
StartTimeSlot parameter  58
stopping, the system or board  37
system
   reconfiguring  37
system initialization  36
System property sheet  39

T
TDM bus clock source
   setting  27
TDM Bus Configuration property sheet  16, 48
TDM Bus parameters  16
TDM Bus Type (Resolved/User Defined) parameter  49
Telephony Bus property sheet  40
third-party boards  24, 27
TraceEnable parameter  44
Transmit Extra Bits parameter  64
Transmit Idle Pattern parameter  65
Transmit National and International Bits parameter  64
Transmit Pulse Digit Make/Break State Definition parameter  66
Transmit Wink Definition parameter  66
TSFFilename parameter  62
TSFFileSupport parameter  45

U
User Defined TDM Bus parameters  16
Using Compatibility Clocks (User Defined) parameter  52
Using NETREF One (User Defined) parameter  53
Using NETREF Two (User Defined) parameter  54
Using Primary Master (User Defined) parameters  53
Using Secondary Master (User Defined) parameters  53

V
verifying device names  33
virtual board
   definition  33
voice parameters
   adjusting
      frequency shift keying  17
      signal delay  18
      silence compressed record  19
volume control  17
Z

Zero Code Supression parameter 69